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Chapter 1. Introduction

Introduction

Starting from 3.0.0.Alphal version, JBoss set of plugins includes tools for supporting JBoss Portal
and JSR-186/JSR-286 portlets. Thus, this guide is intended to explain you how to get started and
manage JBoss Portlet Tools.

1.1. What is JBoss Portal and Portlet Tools?

JBoss Portal provides an open source platform for hosting and serving a portal's Web interface,
publishing and managing its content, and customizing its experience. It supports a wide range
of features, including standard portlets, single sign-on, clustering, and internationalization. More
about JBoss Portal you can find visiting its home page at: http://www.jboss.org/jbossportal/.

With JBoss Portlet Tools you can easily create a Java, JSF and Seam portlet and deploy it to
JBoss Portal.

1.2. Key Features of JBoss Portlet Tools

JBoss Portlet Tools supports the JSR-168 Portlet Specification (Portlet 1.0) [http://www.jcp.org/en/
jsr/detail?id=168] and JSR-286 Portlet Specification (Portlet 2.0) [http://www.jcp.org/en/jsr/detail?
id=286] and works with JBoss Portlet Bridge [http://www.jboss.org/portletbridge/] for supporting
Portlets in JSF/Seam applications. To enable these features, you need to add the JBoss Portlet
facet to a new or an existing web project (see JBoss Portlet Tools Tasks). The project could be
a non-WTP project, but you should know that if it does not have the proper portlet API jar's the
generated classes will have compile errors.

The next table lists key features supplied by JBoss Portlet Tools.

Table 1.1. Key Features of JBoss Portlet Tools

Feature Benefit Chapter
JBoss JBoss Portlet Tools provides the Java, JSF and Seam Portlet facets | JBoss
Portlet that could be enabled for a Web project. Portlet
facets Tools
Tasks
Java The wizard helps create a JSR-186/JSR-286 compliant portlets Java
Portlet Portlet
wizard Wizard
JSF/Seam  This wizard helps create JSF/Seam portlets JSF/Seam
Portlet Portlet
wizard Wizard

1.3. Requirements and Installation

JBoss Portlet Tools needs the following minimal requirements:
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Eclipse 3.4.2/Ganymede

JBoss Tools 3.0.0.Alphal (for higher versions of JBoss Tools make sure
you use the compatible version of Eclipse [http://www.jboss.org/community/wiki/
MatrixofsupportedplatformsruntimesandtechnologiesinJBossToolsJBDS])

JDK 5 or higher

JBoss Portal + JBoss AS bundle from: http://www.jboss.org/jbossportal/download/index.html

» JBoss Portlet Bridge (optionally) from: http://www.jboss.org/portletbridge/downloads.html

JBoss Portlet Tools is included as part of JBoss Tools project. Refer to http://www.jboss.org/tools/
download/installation.html for installation methods of JBoss Tools.
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JBoss Portlet Tools Tasks

2.1. Creating and Deploying a Java Portlet

This chapter shows how to create a Dynamic Web Project, add a Java Portlet to it and deploy
it to the JBoss Portal.

2.1.1. Creating a Web Project with JBoss Portlet Capabilities

Fallow the next procedure to create a Web project with JBoss Portlet capabilities pointed to the
JBoss Portal runtime.

1. Go to File > New > Dynamic Web Project if you are in the Web perspective or File > New >
Other > Web > Dynamic Web Project in any other perspective. The New Dynamic Web Project
wizard appears.
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New Dynamic Web Project

Dynamic Web Project <

Create a standalone Dynamic Web project or add it to a new or Lo
existing Enterprise Application.

Project name: | HelloPortlet |

Project contents

& Use default

Target runtime
| |Boss 4.2 Runtime & | [Ngw...|

Dynamic web module version

[2.5 2l

Configuration

[ Default Configuration for |Boss 4.2 Runtime = | [Mud'rfy... |

A good starting point for werking with |Boss 4.2 Runtime runtime.
Additional facets can later be installed to add new functionality to the
project.

EAR membership

[ Add project to an EAR

Working sets
[ Add project to working sets

@ [ = Back lr Mext = 1|[ Cancel H Finish

Figure 2.1. New Dynamic Web Project
2. Specify the name of the project.

3. Click New in the Target Runtime area to create a JBoss Portal runtime. Choose JBoss
Community > JBoss 4.2 Runtime and select the Create a new local server check box below.
Click Next.
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Mew Server Runtime Environment

Mew Server Runtime Environment
Define a new server runtime environment

Select the type of runtime ervironment:

Bpe biter e l

L S B

[2]

I = |Boss
¥ (&r |Boss Community o
il |Boss 3.2 Runtime
i |Boss 4.0 Runtime

|Boss 4.2 Buntime

i |Boss 5.0 Auntime

i3 |Boss 5.1 Runtime

i |Boss Deploy-Only Runtime
I (= |Boss Enterprise Middleware

al

|Boss Application Server 4.2

[ Create a new local server

@ : |[ Mext = H Cancel H Finish

Figure 2.2. New Server Runtime

4. The New Server Runtime Environment wizard appears. In the Name field, type JBoss Portal
2.7 Runtime, and then use the Browse button to point to the location of JBoss Portal + JBoss
AS extracted. Click Next to proceed.
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Mew Server Runtime Emvironment

. .
|Boss Runtime ® B

i @
|Boss Application Server 4.2 ® @ by fea ot

A |Boss Server runtime references a |Boss installation directory.
It ean be used to set up classpaths for projects which depend on this runtime,
as well as by a "server® which will be able to start and stop instances of |Boss.

MName

[JEasg Partal 2.7 Runtirme ]

Home Directory

|r¢ptrjb oss-portal-2.7.2

|RE
[Defau!t JRE b ] |RE

Configuration

Dire:tury: [gewer [ Browse... l

A all Copy...
s [

3 minimal

@ [ < Back " Mext = ” Canceal ” Finish ]

Figure 2.3. New Server Runtime Environment

5. At this point a new JBoss Server instance will be created. On the next page you can verify the
runtime information defined. If something is incorrect, press Back to return to the previous
wizard page. Click Finish.
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Mew Server Runtime Environment

d .
Create a new |Boss Server ® B

L
|Boss Application Server 4,2 ® @ by rearst

A |Boss Server manages starting and stopping instances of |[Boss.
It manages command line arguments and keeps track of which modules have been deployed.
Funtime Infarmation

if the runtime information below is incorrect, please press back, Installed Runtimes....
and then Add to create a new runtime from a differant lacation.

Home Directory Joptfjboss-portal-2.7.2

JRE fusrflibjjemfjava-1.5.0-sun-1.5.0.16 {java-1.5.0-sun-1.5.0.16)
Configuration Location server

Configuration default

()

Cancel H Finish

Figure 2.4. Target Server

6. Click Modify in the Configuration area to enable a portlet facet for the project.
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New Dynamic Web Project

Dynamic Web Project -.

Create a standalone Dynamic Web project or add it to a new or Lo
existing Enterprise Application,

Project name: | HelloPortlet |

Project contents

Use default
a4

Target runtime

| |Boss Portal 2.7 Runtime & | [Ngw...|

Dynamic web module version

25 +

Configuration

[ Default Configuration for |Boss Portal 2.7 Funtime = | |Mud'rfy...]

A good starting point for werking with |Boss Portal 2.7 Runtime runtime.
Additional facets can |ater be installed to add new functionality to the
project.

EAR membership
[ Add project to an EAR

working sets
[l Add project to working sets

@ [ < Back ]f Mext = ][ Cancel H Finish

Figure 2.5. Setting the Project Configuration

7. In the Project Facets dialog, check JBoss Core Portlet and press OK .
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Project Facets

Project Facets =
Select the facets that should be enabled for this project. @
Configuration: [ <custom> = ] [ Save As... ] [ Delete ]

Project Facet Version Details [w

B[] Asis2 Web Services [ JBoss Core Portlet 2.0

&4 {5 Dynamic web Module @5 " | Adds support for the |ava Portlet API
ava 5.0 -
Aé) ) Requires all of the following facets:
[[] 4* Java Persistence 1.0
O] B JevaScript Toolkit L0 (% Dynamic Web Module 2.5 or newer
’ [4] Java 5.0 or newer
[] ] JavaServer Faces 1.1 .
] 7] |Boss Maven Integration 1.0
= = [] JBoss Portlets
¥ B |Boss Core Portlet
[ [ |Boss JSF Portlet 1.0
[ [ |Boss Seam Paortlet 1.0
[[1 1 JBoss Web Senvices Core 3.0 .
1 [ seam 2.2 -
[ [ webDoclet (XDoclet) 123 -

a) I )

® l Cancel “ oK I

Figure 2.6. Enabling the JBoss Core Portlet Facet

JBoss Portlet Preferences

8. The Java and Web Module pages are for configuring Java and Web modules in the project.
Here all values are set, so leave everything as it is.

9. The last wizard page will ask you to add JBoss Portlet capabilities to the project. Select Portlet
Target Runtime Provider and click Finish to complete the project creation.
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Mew Dynamic Web Project
|Boss Portlet Capabilities
Add |Boss Portlet capabilities to this Web Project

ortlet Implementation Library

Type: | Library Provided by Target Runtime
The User Library

[ Mervd FPortlet Target Runtime Provider
library Disable Library Configuration

@ [ = Back I[ Mext = ]I Cancel “ Finish I

Figure 2.7. Including the Portlet Libraries Provided by Target Runtime

http://www.jboss.org/community/wiki/PortletFacetLibraries

As the result, JBoss Portlet Tools adds JBoss Core Portlet facet to the project, creates an empty
portlet.xm file and adds the JBoss Portlet library to the project classpath.

10
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M@ Project Explor = B
B g -
- & HelloPortlet
8 ere
b =i JRE Systern Library [java-1.5.0-5un-1.5
I+ @ )Boss 4.2 Runtime [|Bess Portal 2.7 Rur
= m)Boss Portlet Libraries
b = portlet-apijar - joptjjboss-portal-2.7
= build
= (=WebContent
P = META-IMF
= (= WEB-INF
= lib

it web xml

al i I B

Figure 2.8. Portlet Project Structure Overview

2.1.2. Adding a Java Portlet to a Web Project

At the previous section you have created a web project with JBoss Portlet capabilities. The next
steps will show you how to add a new Java portlet to the project.

1. Right-click the project and follow to New > Other > JBoss Tools Web > Portlet > Java Portlet.

11
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Select a wizard —

Create a new |ava Portlet

Wizards:
foe ftertox )

[#]

o ¥HTML File
b &SP
= = Portlet
¥ |Boss |]SFfSeam Portlet -
P & Struts
b= Pa

B = Plug-in Developrment

[«]

i) l Mext = ' Cancel |

Figure 2.9. New Java Portlet

2. The Create Portlet wizard starts (for information about the wizard options, see "Java Portlet
Wizard" in the guide reference). The wizard fills in the Project and Source Folder fields for
you. You should specify a Java package and a class name (for instance, org.example and
TestPortlet). Then click Next .

12
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Create Portlet

Create Portlet

=]
Specify class file destination.
Project: | HelloPortlet e
Source falder: [ﬂ—iellnpunlemr: | rErrme...]
|ava package: [nrg.e:u:arnple | rErrme...]
Class name: [Testpqrﬂet I
Superclass: [javax.purt!et.ﬁanaricﬂ'urt!et | rBerm-.rsa...]

[[] Use an exasting Portlet class

| TestPortlet

@ [ < Back lr Mext = '[ Cancel l finish

Figure 2.10. Specifying Class File Destination
3. You may leave the next three pages with default values, on the last one hit Finish.

Once a Java portlet is created, new resources are added to the project structure: a Java portlet
class (Test Portlet.java), defaul t-object.xm and portlet-instances.xm files and the
portlet.xm descriptor is updated as well.

13
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ik, Fi veo P | © 5eam | 0| B

- EiHellorortlet
= @#@sre

= i arg.example
v [ TestPortlet java

b =4 |Boss Portlet Libraries
&= build
= [=WebContent
I = META-INF
=~ = WEB-INF
e=lib
%) default-object.xml
¥ portlet-instances.xmil
%] portlet xml
4y web xml

B % 7=

b @A RE Systemn Library [java-1.5.0-sun-
b =4 )Boss 4.2 Runtime [|Boss 2.7 Portal

(<]

! ]

B}

TestPortlet java 87

package nrg.exarlpi.e;
#import java.io.IOException;[]
public class TestPortlet extends GenericPortlet {

S /* (non-Javadoc)
* @see javax.portlet.GenericPortlet#doView(javax.portl
s
- @Override
protected void doview(RenderRequest request, RenderResp
throws PortletException, I0Exception, Unavailab
response. setContentType (" text/html*);
PrintWriter writer = response.getWriter();
writer.write("Hello world!");
writer.close();

Figure 2.11. Structure of the Project with a Java Portlet

Thus, now the project is ready to be built and deployed.

2.1.3. Deploying a Portlet to JBoss Portal

You can deploy a portlet project in the way you deploy any other web application.

1. Right-click the project and do Run As > Run On Server. The Run On Server wizard starts.

14
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r Run On Server b4
Run On Server

Select which server to use

How do you want to select the server?

® Choose an existing server

) Manually define a new server

Select the server that you want te use:

type filter text

= & localhost
id |Bess 4.2 Runtime Server fia stopped

|Boss Portal 2.7 Server W= Stopped

|Boss Application Server 4.2

[] Always use this server when running this project

® |[ Mext = ” cancel H finish

Figure 2.12. Running the Java Portlet on Server

2. Select JBoss Portal 2.7 Server created before and click Next.

3. Onthe Add and Remove page move the created project to the right and click Finish.
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Run On Server

Add and Remove
Madify the resources that are configured on the server

Move resources to the right to configure them on the server

Available: Configured:

(& Helloportlet

[ Cancel H Finish

Figure 2.13. Deploying the Portlet Application
It will deploy the portlet application and start JBoss AS.

4. Use the http://localhost:8080/portal/portal/default/default URL to see your portlet in the browser.

16
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1] TestPortlet java {3 JBoss Portal 2.7.2-GA 2 =0

L] m [http-:.f.flucalhust:BDBD{purta!..fpurtal.u'defauludeFault v| B n

TestFortet

Helle Weorkd

Powered by JBoss Pora

Figure 2.14. Java Portlet in the Browser Window

2.2. Creating and Deploying a JSF Portlet

This chapter will explain how you can configure a JSF portlet within a JSF project with JBoss
Portlet capabilities and then deploy it to JBoss Portal.

2.2.1. Creating a JSF Project with JBoss Portlet Capabilities

You can create a JSF project with JBoss Portlet capabilities in two ways:

1. Create a dynamic Web project with the JavaServer Faces and JBoss JSF Portlet facets enabled
(the steps to proceed)

2. Or create a JSF project using the wizard JBoss JSF Tools provides, then enable JSF and JBoss
Portlet facets and add JBoss Portlet capabilities ( the steps to proceed)

Refer to the further sections for the procedures on how to do this.

2.2.1.1. Creating a Dynamic Web Project with the JBoss Portlet
Capabilities

The basic steps to create a dynamic Web project with the JBoss Portlet capabilities are as follows:

1. Start the Dynamic Web Project wizard navigating to File > New > Other > Web > Dynamic
Web Project.

17
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Tip:
\

You can also select the perspective and then go to

£

New Dynamic Web Project x
Dynamic Web Project

Create a standalone Dynamic Web project or add it to a new or Lo
existing Enterprise Application,

Project name: [JSFF'urtlethw:tl |

Project contents

& Use default
l ptfworkspace3/|SFPortletProject 1 _ |

Target runtime

[EEH&H&QH — 3] [Ngw]
Dynamic web module version

(24 3
~Configuration

[Dahuh Configuration = ] |Mudi‘hr...]

The default configuration provides a good starting peint. Additional facets
can later be installed to add new functionality te the project.

EAR membership
[ Add project to an EAR

SFPartletProject LEAR |v |

‘Working sets
[ Add project to working sets
@ [ = Back ][ Mext = ] [ Cancel ] I Finish |

Figure 2.15. Setting the JSF Configuration

2. Specify the project name and set the target runtime to JBoss Portal by following the points 3,
4 and 5 in the "Creating a Web Project with JBoss Portlet Capabilities" procedure.

18
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3. In the Configuration area, click Modify and enable JavaServer Faces, JBoss Core Portlet and
JBoss JSF Portlet facets. Hit OK.

£ Project Facets b
Project Facets
Select the facets that should be enabled for this project. \?
Configuration: | <custom> | [ SaveAs.. || Delete |
Project Facet Version WM|
» B Axis2 web Senvices @ Axis2 Web Services
& £ Dynamic Web Module 25 Enables Web services generation through the
[+] ] Java 5.0 * | Awis2 Web services engine.
[_] % Java Persistence 1.0
[ [ Javascnpt Toolkit 1.0
[« | JavaServer Faces 1.2 -
1 2 |Boss Maven Integration 1.0
= [=] [ |Boss Portlets
(¥ 21 |Boss Core Portlet 2.0 -
(¥ [ |Boss JSF Portlet 1.0
[ [ |Boss Seam Portlet 1.0
] ] |Boss Web Senvices Core 30 -
[ £ seam 2.2 -
] 2 webDoclet (xDoclet) 1.2.3 -

":_'_?3 Cancel l oK I

Figure 2.16. Enabling the Portlet Facets
4. You may leave the next two wizard pages with defaults, just press Next to proceed.

5. On the JBoss Portlet Capabilities page, select Portlet Target Runtime Provider and click Next.

19
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New Dynamic Web Project

|Boss Portlet Capabilities
Add |Boss Portlet capabilities to this Web Project '
ortlet Implementation Library

The targeted runtime contains a portlet ibrary. Selecting this option
will configure the classpath container that includes the library.

@ [ = gack H Mext = ” Cancel “ Einish |

Figure 2.17. JBoss Portlet Capabilities

Tip:
@

All types of the portlet implementation library are described more closely in the
wiki article at: http://www.jboss.org/community/wiki/PortletFacetLibraries.

6. Next wizard page is for configuring JSF capabilities. You can leave everything as it is here.

20
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MNew Dynamic Web Project

|SF Capabilities
Add |SF capabilities to this Web Project

J5F Implementation Library
Type: | Library Provided by Target Runtime

Selecting this option will configure the project to use that librany

~ |

£

The targeted runtime is able to provide the library required by this facet.

|SF Configuration File: [MFEB-INFrfaces-cnnﬁg_xml

|SF Sendet Mame: [Fa{ a5 Sendet

|SF Sendet Classname: [jauax.faces.webapp.FaI:EESEr'-let

URL Mapping Patterns: facesp*

Add...

Figure 2.18. JSF Capabilities

7. On the JBoss JSF Portlet Capabilities page, select JSF Portlet Target Runtime Provider as the
JSF portlet implementation library. It will copy Portlet Bridge libraries from the server runtime

to the project classpath.

21
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New Dynamic Web Project
jBoss |SF Portlet Capabilities
Add |Boss |SF Portlet capabilities to this Web Project
A5FPortlet Implementation Library
Type: MSF Paortlet Target Runtime Provider

o

o

The targeted runtime centains a |SF portlet library. Selecting this
option will copy libraries from the Server Puntime.
Richfaces Capabilities
[[] add/change Richfaces Libraries

[_u::rar.es provided by richfaces distribution | = ]

[ | [F:':'..-.-qr—...]

@ l < Back ][ Mext = I| Cancel “ Binizh '

Figure 2.19. JBoss JSF PortletCapabilities

Tip:

On this page, it is also possible to add the RichFaces libraries from the
RichFaces distribution by checking

http://community.jboss.org/wiki/PortletFacetLibraries

8. Click Finish. The project will be created in the workbench.

22
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2.2.1.2. Creating a JSF Project and adding the JBoss Portlet
Capabilities

How to organize a JSF project you can find out in the JSF Tools User Guide [../../
jsf_tools_ref_guide/html_single/index.html#new_jsf_project]. Just remember to point the target
runtime to JBoss Portal directory location (see how it is done for a dynamic Web project: steps 3,
4 and 5 in the "Creating a Web Project with JBoss Portlet Capabilities” procedure).

Mew |SF Project

Web av

Senvet Version |2.'5 v |

Context Path* [jEFF‘ﬂrtIeT.PrﬂjE{t]

Funtime* ||Boss Portal 2.7 Runtime v New.
enyer |

Lbitnd s ¥ |Bass Portal 2.7 Server | New...
Select All |

Deselect All |

| cancel || Finish

Figure 2.20. Creating New JSF Project

To add the JBoss Portlet capabilities to the created JSF project you should complete the next
steps:

1. Right-click the project and click Properties to open the project Properties sheet. Select Project
Facets on the left and enable the JavaServer Faces, JBoss Core Portlet and JBoss JSF Portlet
facets.

23
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4.

Properties for [SFPortletProject2

Project Facets =
Resource 2 ) o — I
auilders Configuration: | <custom=> || Save As.. Delete
Drools Project Facet Version Details | Runtimes
FreeMarker Context B[] [ Axis2 web Services || JBoss |SF Portlet 1.0
Hibernate Settings ¥l (55 Dynamic web Module 25 Adds support for the |SF Portlet.
Java Build Path M eve . 80 Rrequires all of the following facets:
b Java Code Style | 4+ Java Persistence 1.0 B ;
P Java Compiler [ [ JavaSenpt Toolkit 1.0 " j?;irz:r:f;;:::ijl; i’?n::iwer
b Java Editor [¥] 7] JavaServer Faces 1.2 " || [4) java 5.0 or newer
Java EE Module Deg ] 7] JBoss Maven Integration 1.0 || JavaServer Faces 1.2 or newer
Javadee Location = [= [[] |Boss Portlets
I+ Javascript b [ JBoss Core Portlet 2.0 -
e vt
JSP Fragment [ & JBoss Seam Portlet 1.0
Madule Assembly 1 7] JBoss Web Senvices Core 3.0 -
project Archives [J [ seam 2.2 -
[ [ webDoclet (xDoclet) 123 -
Project References
Run/Debug Settings
Seam Settings
Server
Service Policies
Targeted Runtimes -
Task Tags i Further configuration available...
b walidation =) — | I Apply 1
(s
'@ [ cancel || oK

. Notice, "Further configuration available...'

Figure 2.21. Project Facets

warning appears at the bottom of the screen. It
means that next you should configure the JSF Portlet capabilities in the project. Click the link.
The Modify Faceted Project wizard appears.

. Complete all wizard pages the same way as described in the steps 5, 6, 7 of the "Creating a

Dynamic Web Project with the JBoss Portlet Capabilities" procedure. Hit OK.

To apply the changes click Apply and then OK to close the project Properties sheet.

2.2.2. Adding a JSF Portlet to the Project and Deploying It to
JBoss Portal

The previous section has shown how to create a JSF project with JBoss Portlet and JSF Portlet
capabilities enabled. Use the following procedure to add a JSF portlet to the created project and
deploy it to JBoss Portal.

1.

Call the Create Portlet wizard by navigating to New > Other > JBoss Tools Web > Portlet >
JSF/Seam Portlet on the context menu of the project (for information about the wizard options,
see "JSF/Seam Portlet Wizard" in the guide reference).
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2 Mew x

Select a wizard

[e——
Create a new |Eoss |SF Portlet f_

Wizards:

I I

[2]

= [= Portlat
¢ Java Portlet

F) |80ss |SF/Seam Portlet
= Struts
= JPA
= oXygen -
= Plug-in Development
= Seam

e

- -

(<]

® [ gec e J[ enish ][ cancel ]

Figure 2.22. Calling New Portlet Wizard

Tip:

As you see, the JSF and Seam Portlet wizards are merged into one. We have
set the JSF configuration for the project, so the default values in this wizard will
be set as for a JSF portlet.

2. Leave all the wizard pages with default values by clicking the Next button, on the last one click
Finish to complete the JSF portlet creation.

3. Complete the steps described in the "Deploying a Portlet to JBoss Portal" procedure to deploy a
JSF portlet to JBoss Portal. Just use the other URL to see it in the browser: http://localhost:8080/
portal/portal/default/JSFPortlet.
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 Internal Web Browser 3 =0

& ® & |httpyflocalhost:8080/portalportalidefaultjsFrortiet v » B

JBoss JSF Portlet

< | »

Figure 2.23. JSF Portlet in the Browser

2.3. Creating and Deploying a Seam Portlet

This chapter covers the steps on how to configure a Seam portlet within a Seam project with the
help of the JBoss Portlet Tools features.

2.3.1. Creating a Seam Project with JBoss Portlet Capabilities

Follow one of two ways of creating a Seam project with JBoss Portlet capabilities enabled:

1. Create a dynamic Web project with the Seam and JBoss Portlets facets enabled (the steps
to proceed)

2. Or create a Seam project with the JBoss Seam portlet configuration using the wizard JBoss
Seam Tools provides and follow all the wizard steps to enable JBoss Portlet capabilities (the
steps to proceed)

2.3.1.1. Creating a Dynamic Web Project with Seam and JBoss
Portlet Capabilities

To create a dynamic Web project with Seam and JBoss Portlet capabilities you should take the
following steps:
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1. In the File menu, go to New > Other > Web > Dynamic Web Project. The New Dynamic Web
Project wizard starts.

New Dynamic Web Project

Dynamic Web Project ( 1.

Create a standalone Dynamic Web project or add it to a new or ‘,_o
existing Enterprise Application.

Project name: | seamPortletProjectl |

Project contents

Use default
|

Target runtime

Nore>  3[new.]

Dynamic web module version

[2.4 -
Configuration
[Default Configuration e | |Mul;|'rfy...]

The default configuration provides a good starting point. Additional facets
can later be nstalled to add new functionality to the project.

EAR membership
[ Add project to an EAR

Working sets

[ Add project to working sets

@ [ < Back lf Mext > ][ Cancel ] Einish ]

Figure 2.24. Creating a New Dynamic Web Project

2. Give the project a name and follow the steps 3, 4, 5 of the "Creating a Web Project with JBoss
Portlet Capabilities" procedure to set the target runtime.

3. In the Configuration area of the first wizard page, select JBoss Seam Portlet Project v2.0. It
will add needed facets to the project.
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Tip:
\

If you now click the button, you should see the

and facets enabled.

4

Project Facets

Project Facets

Select the facets that should be enabled for this project. @
Configurations: | <custom=> g ][ Save As... I Jelete |
Project Facet Version || Details ||-‘u1ﬁmes]
P [0 & Ads2 Web Senvices ' |Boss Seam Portlet 1.0
9 Dynamic Web Module . Adds support for the Seam Portlet,
ava 5.0
& ) Requires all of the following facets:
[] 4+ Java Persistence 1.0 _
(7 B Javascript Toolkit 10 C'a Dynamic Web Module 2.3 or newer
| |Boss Core Portlet 1.0 or newer
[ Javaserver Faces 1.2

|| |Boss |SF Partlet 1.0 or newer

= [ [ |Boss Portlets [3] Java 5.0 or newer

1 [ |Boss Core Portlet 2.0 || JavaServer Faces 1.2 or newer
W) [ Joss JSF Portlet 1.0 i Seam 2.0 or newer
¥ B |Boss Seam Portlet
b [ [ |Boss Web Services
[ seam 2.0
[ ) webDoclet (XDoclet) 1.2.3
(I I I ol W | )]
@ OK I [ Cancel

Figure 2.25. Project Facets

4. The next two pages are for adjusting the project Java and Web modules. They include the
default values, so you can skip them by pressing Next.

5. On the Jboss Portlet Capabilities page, select Portlet Target Runtime Provider as the portlet
implementation library.
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Tip:
\

All types of the portlet implementation library are described more closely in the
wiki article at: http://www.jboss.org/community/wiki/PortletFacetLibraries.

6. The next page is for configuring JSF capabilities. As it contains the default values, just click
Next to proceed.

7. On the Seam Facet page, set a Seam runtime and a connection profile.

Tip:

For details about how to set a Seam runtime and a connection

profile, see "Configure Seam Facet Settings" [../../seam/html_single/
index.html#seamFacet] in the Chapter 2, "Seam Dev Tools Reference Guide"
[../../lseam/html_single/index.html].
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New Dynamic Web Project

Seam Facet "
Configure Seam Facet Settings \f

~General

Searm Runtimea: | jboss-seam-2.0.2.GA o ] [Add...]

Deploy as: ® WAR ) EAR

Database

Databasze Type: [HSQL o ]

Connection profile: | MNew HSQLDE £ | {Edit...l |[Ne‘wi

Database Schema Name: [ ]

Database Catalog Name: [ ]

DB Tables already exists in database: O
Recreate database tables and data on deploy: [

-Code Generation-

Session Bean Package Mame: [:lrg.dumain.seampurtletpmje:t1.5ess'n:rr1 ]

Entity Bean Package MName: larg.domain.seampnrtlel:prnjen:tl_entit_y ]

Create Test Project: il
Test Package Mame: [clrg.domain.seampartletprujectl.test ]
@ I = Back ][ Mext = ] I Cancel ] [ Binish

Figure 2.26. Seam Facet Settings

8. On the JBoss JSF Portlet Capabilities page, select the JSF Portlet Target Runtime Provider
type of the implementation library.

Tip:

If you have downloaded, alternatively you can select
and then provide a path to the
distribution.
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Mew Dynmamic Web Project

|Boss |SF Portlet Capabilities
Add |Boss |SF Portlet capabilities to this wWeb Project

J&FPortlet Implementation Library

The targeted runtime contains a |5F portlet library. Selecting this
option will copy libraries from the Server Runtime.

Richfaces Capabilities
| Addjchange Richfaces Libraries

@ = Back .| | cancel || Firish |

Figure 2.27. Setting Portlet Bridge Provider
It will add JBoss Portlet Bridge libraries to the project classpath.

9. Hit Finish to complete the project creation.

2.3.1.2. Creating a Seam Project with JBoss Portlet Capabilities

The steps to create a Seam project with JBoss Portlet capabilities are as follows:

1. In the File menu, go to New > Other > Seam > Seam Web Project. The New Seam Project
wizard appears.

2. Next steps are the same as in the "Creating a Dynamic Web Project with Seam and JBoss
Portlet Capabilities”" procedure starting from the step 2.

2.3.2. Adding a Seam Portlet to the Project and Deploying It to
JBoss Portal
The previous section has shown you how to create a Web project with Seam and JBoss Portlet

capabilities. Now you can create a Seam portlet and deploy it to JBoss Portal by following the
next procedure:
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1. In the File or context menu of the project go to New > Other > JBoss Tools Web > Portlet >

JSF/Seam Portlet.

I MNew x

Select a wizard —

Create a new |Boss |SF Portlet

Wizards:
Boceriod ]

[#]

5 TLD File
™ web Descriptar
i XHTML File
P =|SF L
= [= Portlet

¥ Java Portlet

|Boss |SF/Searmn Portlet

I = Struts

[«]

@ l Mext = ' Cancel

Figure 2.28. Calling the Create Portlet Wizard

2. The Create Portlet wizard starts (for more information about wizard options, see "JSF/Seam
Portlet Wizard" in the guide reference). As the Seam configuration is set for the project, the

wizard puts the values as for Seam portlet.
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] Create Portlet

Create Portlet

Enter portlet deployment descriptor specific information,

Mame: IseamP ortlet

Display name: ||Boss Searm Portlet

Title: ||Boss Seam Portlet

Description:

Portlet Modes
Wiew [] Edit [] Help

Initialization Parameters:

javax.portlet faces.d jhormexhtml

Name Walue Description

| [ add... |

Cancel

Figure 2.29. Creating Seam Portlet

3. Next two pages are filled out with default values, just press Next to proceed. On the last one

click Finish to complete.

4. To deploy and run the portlet on JBoss Portal complete the steps described in the

"Deploying

a Portlet to JBoss Portal" procedure. Just use the following URL to see it in the browser: http://

localhost:8080/portal/portal/default/SeamPortlet.
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@ Internal Web Browser B . =0

=] m P [http:.f.l’lucalhust:Eﬂﬂﬂfpurtalfpurtal.u'defaultﬁearnPclrt!et:jsessiunid=363ﬂlI V| =3 -

Fowered by JBoss Port

(el 2]

Figure 2.30. Seam Portlet in the Browser Window
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Reference

This chapter includes detailed reference information about JBoss Portlet Tools.

3.1. JBoss Portlet Descriptors

In order to a web project with portlets could be deployed to JBoss Portal, it should include certain
descriptors. The next table lists and describes these configuration files.

Table 3.1. JBoss Portlet Descriptors

Name Description

portlet.xml The mandatory portlet descriptor defined
by the JSR-168 Portlet Specification [http://
www.jcp.org/en/jsr/detail?id=168]. It is used
during deployment.

portlet-instances.xml The optional JBoss Portal specific descriptor. It
allows to create a portlet instance from a portlet
class definition.

*-object.xml The optional JBoss Portal specific descriptor. It
helps define the layout of the portal.

jboss-portlet.xml The optional JBoss Portal specific descriptor. It
allows to use JBoss specific functionality within
a portlet application.

For more detail information about each descriptor, see "Portlet Descriptors"” [http://docs.jboss.org/
jbportal/iv2.7.1/referenceGuide/html_single/#descriptors_portlet] in Chapter 6, "JBoss Portal
Reference Guide" [http://docs.jboss.org/jbportal/v2.7.1/referenceGuide/html_single/].

3.2. Wizards

This section describes the JBoss Portlet Tools wizards:

¢ Java Portlet wizard

* JSF/Seam Portlet wizard

3.2.1. Java Portlet Wizard

The Java Portlet wizard helps you create a new Java portlet (1.0 or 2.0). It is based on the WTP's
Create Servlet wizard, but adapted to JBoss Portlet. You can call it from the File or context menu
of your project by following to New > Other > JBoss Tools Web > Portlet > Java Portlet.
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The wizard consists of the four pages:

1. The first one includes the next options to adjust:

Table 3.2. Java Portlet Wizard. First Page Options.

Option

Project

Source folder

Description

Select the project to add a new Java portlet

The path to the source folder relative to the selected
project

Default

The project
selected when
the wizard has
been started

The source
folder of the
project selected
in the Project

field
Java package Enter a package to contain a new portlet. Either type a | <blank>
valid package name or click Browse to select a package
via the dialog box.
Class name Type a name for a new Java portlet class <blank>
Superclass Type or click Browse to select a superclass for a Java | javax.portlet.Gene

portlet class

Use an existing
Portlet class

Select this check box if you want to use an existing Java
portlet class. In the appeared Class name field type or
click Browse to select an existing portlet class.

Cleared

2ricPortlet

2. The second wizard page is for specifying modifiers, interfaces to implement and method stubs

to generate.
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Create Portlet

Create Portlet

generate.
Madifiers:

Interfacas:

] init
1 doview
[ deDispatch

&

Which method stubs would you like to create?
[[] Constructors from superclass

i Inherited abstract methods

=
Specify modifiers, interfaces to implement and method stubs to @
[] Fimal
| Add... |
[ destroy ] getPortletConfig
[l doEdit ] doHelp
[[) processaction | render
| cancel || Finish

Figure 3.1. Second Page of the Java Portlet Wizard

The descriptions of the options listed on this page are in the following table.

Table 3.3. Java Portlet Wizard. Second Page Options.

Option Description Default
Modifiers Select one or more access modifiers for a new Java Public
portlet class:
* Public
* Abstract
¢ Final
Interfaces Click Add to choose interfaces that a new class <blank>
implements
Which method Choose which methods from superclass to override in | Inherited
stubs would you | the Java portlet class: abstract
like to create? methods,
« Constructors from superclass doView
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Option Description
« Inherited abstract methods

e init

* doView

« doDispatch
 destroy

+ doEdit

e processAction
 getPortletConfig
< doHelp

* render

Default

3. The third page is for adjusting the portlet deployment descriptor settings.

Create Portlet

Create Portlet
Enter portlet deployment descriptor specific information.

Mame: [_TestPnrtlet

Display name: [Tastportlet

Title: [_TustPurtlet

Description: f

Portlet Modes
View [ Edit [] Help

Initialization Parameters:

Mame Value Description

_ [ Add... |

[ Cancel H

Finish

Figure 3.2. Third Page of the Java Portlet Wizard
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Table 3.4. Java Portlet Wizard. Third Page Options.

Option

Name

Display name

Description

Enter the portlet name. It does not have to be the
portlet class name.

Enter the display name of the Java portlet

Default

The name of the
portlet class

The name of the
portlet class

Name, Value and Description (optional) fields to set a
parameter.

Title Enter the title of the portlet The name of the
portlet class
Description Enter the description of the portlet's function <blank>
Portlet Modes Select one or more of three modes defined by the View
JSR-286 specification:
* View - generates markup reflecting the current state
of the portlet;
« Edit - allows customizing the behavior of the portlet;
« Help - provides an information on how to use the
portlet.
Initialization Specify initialization parameters to create an initial <blank>
Parameters state inside your portlet class. Click Add and fill in the

4. The last wizard page helps configure the JBoss Portlet specific descriptors.
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I

Create Portlet

If Existe:

Instance Name:
Page Name:
window Name:
Parent Reference:
Ragion:

Height:

=
Enter |Boss portlet specific infformation Qg

] Create Portlet Instance

Initial Window State: | maximized

@ [ <gack |

Create Portlet »®

L]

| overwrite

[TestPortletinstance
(

| TestPortletwindow

| default default

|eanter

[1

<F

| cancel || Finish

Figure 3.3. Last Page of the Java Portlet Wizard

Table 3.5. Java Portlet Wizard. Last Page Options.

Option Description Default
Create Portlet Clear the Create Portlet Instance check box, if you Selected
Instance don't wont the wizard to create the deployment

elements in the def aul t - obj ect. xm and portlet-

i nstances. xnl files
If Exists Select one of two options: overwrite

< overwrite - destroys the existing object and creates
a new one based on the content of the deployment

» keep - maintains the existing object deployment or
creates a new one if it does not exist

Instance Name

Enter a name of the portlet instance that the portlet
window represents

[Portlet class
name]instance

Page Name

If set, the portlet page is created with the name
defined

<blank>
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Option Description Default

Window Name | Enter a name of the portlet window [Portlet class
name]Window

Parent Define a reference to the parent object. The syntax for | default.default

Reference this element is [ port al -i nst ance] . [ port al - page] .

For example, def aul t . def aul t means that the
window appears on the default page, in the default

portal.
Region Specify the region where the window should appear center
on the page
Height Define the height of the window 1
Initial Window Set the window state indicator by selecting one of maximized
State three states defined by the JSR-168 specification:

* normal - a portlet shares this page with other
portlets

e minimized - a portlet may show very little
information or none at all

* maximized - a portlet may be the only portlet
displayed on this page

3.2.2. JSF/Seam Portlet Wizard

The JSF/Seam Portlet wizard, that is merged into one JSF and Seam Portlet wizards, helps
you create a JSF/Seam portlet that uses the JBoss Portlet Bridge libraries. The default values
in this wizard depend on the configuration set for the project. For instance, if you set the JSF
configuration, the default values in this wizard will be as for a JSF portlet.

The JSF/Seam Portlet wizard could be started from the File or context menu of your project by
following to New > Other > JBoss Tools Web > Portlet > JSF/Seam Portlet.

The wizard includes three pages to adjust JSF/Seam portlet setting:

1. The first wizard page asks to select a project to add JSF/Seam portlet and set a class file
destination.
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Create Portlet

Create Portlet @
Specify class file destination. "
Project: ' |SFPaortletProject 1 o
Class name: [javax.purtlet.fa:es.GenericFacesPurtlet Browse...

'fii | ] Firish

Figure 3.4. First Page of the JSF Portlet Wizard

Table 3.6. JSF/Seam Portlet Wizard. First Page Options.

javax.portlet.faces.GenericFacesPort

Option Description Default
Project Select the project to add a new JSF/Seam portlet The project
selected when
the wizard has
been started
Class name Type or click Browse to select a class for a JSF/Seam
portlet

2. The second page allows to configure a portlet deployment descriptors.

42



Chapter 3. Reference

I

Create Portlet

Mame:
Display name:
Title:
Description:

Portlet Mades

MName

=
Enter portlet deployment descriptor specific information. Q)

¥ View ¥ Edit & Help

Initialization Pararmeters:

javax.portlet faces [jsfiiewjsp
javax.portlet faces jisfledit jsp

javax.portlet faces fjsfihelpjsp

@ ( < Back I Mext = || cancel | Finish

Create Portlet x

nPortlet |

||Boss |SF Portlet

||Boss |SE Portlet

Walue Description | Add... |

Figure 3.5. Second Page of the JSF Portlet Wizard

Table 3.7. JSF/Seam Portlet Wizard. Second Page Options.

Option Description Default (JSF /
SEEEN))
Name Enter the portlet name. It does not have to be the riPortlet /
portlet class name. seamPortlet
Display name Enter the display name of the Java portlet JBoss JSF
Portlet / JBoss

Seam Portlet

Title

Description

Portlet Modes

Enter the title of the portlet

Enter the description of the portlet's function

Select one or more of three modes defined by the
JSR-286 specification:

JBoss JSF
Portlet / JBoss
Seam Portlet

<blank>

View, Edit,
Help / View
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Description

Default (JSF /

« View - generates markup reflecting the current state
of the portlet

« Edit - allows customizing the behavior of the portlet

¢ Help - provides an information on how to use the

portlet
Initialization Specify initialization parameters to create an initial
Parameters state inside your portlet class. Click Add and fill in the

Name, Value and Description (optional) fields to set a
parameter.

Seam)

javax.portlet.faces.defaultViewld.viev
javax.portlet.faces.defaultViewld.edit
javax.portlet.faces.defaultViewld.helg
javax.portlet.faces.defaultViewld.viev

3. The last wizard page helps you configure the JBoss Portlet specific information.

If Exists:

Create Portlet

Enter |Boss portlet specific information

] Create Portlet Instance

Instance Mame:

Page Name: f_lSF Partlet

window Name: -jSF Portletwindow

Parent Reference: default

Ragion: center

Height: 1

Initial Window State: rraxirmized =

W Create |Boss Application

|Boss Application Name: |rPortletApp
| Add the jboss-portlet xml file

[] Copy JSF Templates

f‘._. Eack |

Create Portlet

averwrite

i

|SFPortletinstance

cancel | Finish

Figure 3.6. Third Page of the JSF Portlet Wizard
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Table 3.8. JSF/Seam Portlet Wizard. Third Page Options.

Option Description Default (JSF /
Seam)
Create Portlet Clear the Create Portlet Instance check box, if you Selected
Instance don't wont the wizard to create the deployment
elements in the def aul t - obj ect. xnl and portlet-
i nstances. xnl files
If Exists Select one of two options: overwrite
< overwrite - destroys the existing object and creates
a new one based on the content of the deployment
» keep - maintains the existing object deployment or
creates a new one if it does not exist
Instance Name | Enter a name of the portlet instance that the portlet JSFPortletinstance /
window represents SeamPortletinstance
Page Name If set, the portlet page is created with the name JSFPortlet /
defined SeamPortlet
Window Name | Enter a name of the portlet window JSFPortletWindow /
SeamPortletWindow
Parent Define a reference to the parent object. default
Reference
For example, def aul t means that the page appears
in the default portal.
Region Specify the region where the window should appear center
on the page
Height Define the height of the window 1
Initial Window Set the window state indicator by selecting one of maximized
State three states defined by the JSR-168 specification:
< normal - a portlet shares this page with other
portlets
* minimized - a portlet may show very little
information or none at all
¢ maximized - a portlet may be the only portlet
displayed on this page
Create JBoss Select to add the j boss- app. xnl descriptor. Selected
Application
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Option

Description

Default (JSF /

Seam)

riPortletApp / seamPortletApp - the default name of
the JBoss application. You can change it by typing a
new one in the JBoss Application Name field.

Add the jboss-
portlet.xml file

Copy JSF
Templates

Select to create the j boss-portlet.xm file

Select to add the folder with JSF templates
(edit.jsp, hel p.jsp,view jsp)to the project

Selected

Cleared

3.3. JBoss Portlet Preferences

To open JBoss Portlet Preferences property sheet, goto Window > Preferences and then JBoss
Tools > JBoss Portlet.

Preferences

JBoss Portlet

Ere= fiter te B

I Help
HAQL editor

=1 -

Check Puntimes for Partlet Components

InstalllUpdate
Java
JavaScript

|Boss jBPM

d v v v v

|Baoss Tools
|Boss ESB Runtim
P web
JPA
b Model validation
b Plug-in Developrment
Project Archives

b Pun/Debug -
P Server

Service Policies

P Team

 Restore QEFaults.[ Apply |

(i) | Ok | Cancel

Figure 3.7. JBoss Runtime Preferences

The Check runtimes for Portlet Components option makes the JBoss Portlet functionality always
visible no matter what the runtime is set. By default the option is checked.
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Summary

In conclusion, with this document you could easily get started with JBoss Portlet Tools. The above
chapters walked you through the steps on how to organize a web project with JBoss Portlet
capabilities enabled, create a Java portlet, JSF or Seam portlet and deploy them to JBoss Portal.
The document also includes the reference of JBoss Portlet Tools features.

If you have questions or suggestions concerned both the documentation and tools
behavior, you are welcome to JBoss Tools Users forum [http://www.jboss.com/index.html?
module=bb&op=viewforum&f=201].

Please, use Jira [https://jira.jboss.orgl/jira/browse/JBDS] to report bugs and requests on
documentation.

4.1. Other Relevant Resources on the Topic

« JBoss Portal home page: http://www.jboss.org/ibossportal/

* JBoss Portal Wiki at: http://wiki.jboss.org/wiki/JBossPortal

« JBoss Portal documentation set at: http://docs.jboss.org/jbportal/

» JBoss Tools home page at: http://www.jboss.org/tools/

* The latest JBossTools/JBDS documentation builds at: http://download.jboss.org/jbosstools/
nightly-docs/

« JBoss Developer Studio/JBoss Tools release documentation you can find at http:/
docs.jboss.org/tools [http://docs.jboss.org/tools/] in the corresponding release directory.
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